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Preface 

 

What This Book is About 
Welcome to the Undelete for Windows User’s Manual. Although software manuals are often one of the 

least-favorite pieces of reading material around, we intend to make this one as painless as possible. This 

book will help you get Undelete quickly installed and running, and it describes the various Undelete 

features and how to use them. 

Structure of This Book 
 Chapter 1 describes how to install Undelete. 

 Chapter 2 describes how to operate Undelete and explains the various features. 

 Chapter 3 describes the installation and operation of Emergency Undelete. 

 Chapter 4 describes using the PushInstall feature to install the Undelete Desktop Client across your 

network. 

 Appendix A shows where to get answers to frequently asked questions. 

 Appendix B has a table showing the operating systems supported by the different Undelete editions. 

 Appendix C explains how to contact your Diskeeper Corporation Customer Service Representative for 

Support Services. 

 

Getting Started 

The Undelete Server, Professional and Home Editions are unique file recovery solutions for Windows 

2000, Windows XP and Windows Server 2003. For simplicity, this User’s Manual will refer to all the 

editions collectively as Undelete. Any differences between the different editions will be clearly noted. 

Undelete incorporates cutting-edge technology developed by Diskeeper Corporation—the same folks who 

developed Diskeeper®, the world’s most popular disk defragmenter.  

When you delete a file, the file is automatically captured and stored in the Undelete Recovery Bin. Much 

like the Windows Recycle Bin, the file is still available should you need to recover it. However, Undelete 

captures files the Windows Recycle Bin misses, such as files deleted from shared network folders, files 

deleted from the Windows command prompt, or the files deleted by Microsoft Office applications when 

newer versions of a file are saved. 

But what about files purged from the Recycle Bin (or the Undelete Recovery Bin, for that matter), or files 

deleted before Undelete is installed? Undelete also allows you to search for and recover files that have been 

deleted—even after you’ve really deleted them by emptying your Recycle Bin, or by deleting files from 

Windows Explorer or other applications.  
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Overview of Undelete 
Undelete is available in several editions—Server and  Professional Editions for professional use, and a 

Home Edition for home users.  

All three editions of Undelete are made up of these major components: 

 Recovery Bin 

 Search Disk 

 Version Protection for Microsoft Office files 

 Emergency Undelete 

In addition, Undelete Server Edition also supports the Undelete Desktop Client, a file recovery “browser” 

for use in a corporate network setting. 

These components and the Undelete Desktop Client are described in the following sections. 

Recovery Bin 
The Recovery Bin feature is similar to the Windows Recycle Bin. Deleted files aren’t really deleted—

they’re simply moved to the bin and held there until the bin is “emptied” or purged. This allows you to 

recover files easily after they have been deleted. However, the Recovery Bin differs from the standard 

Windows Recycle Bin in several important ways: 

 It allows you to recover files deleted by any method, including Windows Explorer and other 

applications—even files deleted from the Windows command prompt!  

 You can have a Recovery Bin for any individual disk volumes on your computer, or use a single, 

“common” Recovery Bin for all your disk volumes. 

 When files are “deleted” and moved by Undelete into the Recovery Bin, they are displayed in a 

manner very similar to Windows Explorer. You (or your users) can see and recover the deleted files 

and the folders as easily as browsing for “normal” files. You can also right-click on a file to recover it, 

open it, or really delete it. 

 The Server, Professional and Client editions of Undelete allow you to see the contents of the Recovery 

Bins on remote computers running Undelete Server Edition, allowing you or your users to recover 

“deleted” files across your network (typically from network file servers). This feature alone is a “life 

saver” for many System Administrators and Help Desk technicians. It’s no longer necessary to search 

backup tapes when a network user accidentally deletes a file from the file server. 

There are actually two different ways you can recover deleted files from remote Recovery Bins: 

Mapped share access and node-to-node access.  

Computers running Undelete Server, Professional or Client can access deleted files from mapped 

network shares (if the computers where the shares reside are running Undelete Server Edition). 

Computers running Undelete Server have the added capability of being able to access the full 

Recovery Bin on remote computers running either Undelete Professional Edition or Undelete Server 

Edition. 

See Chapter 2 for more information about the Recovery Bin. 

Search Disk 
The Search Disk feature allows you to search for and recover files that have really been deleted, such as 

files purged from the Recovery Bin, or files that were deleted when the Recovery Bin was not enabled. The 
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Search Disk feature can also be used to recover files from volumes or directory folders that have been 

excluded from Recovery Bin processing. 

Both the Recovery Bin and the Search Disk features can be accessed from either the Undelete graphical 

user interface, or from the Windows command prompt. 

Note that encrypted files cannot be recovered with the Search Disk feature.  

See Chapter 2 for more information about the Search Disk feature. 

Version Protection for Microsoft Office Files 
Undelete captures commonly-used Microsoft Office files when they are overwritten during a save 

operation. This allows you or your users to recover previous versions of Microsoft Word, Excel and 

PowerPoint files. 

See Chapter 2 for more information about Version Protection for Microsoft Office files. 

Undelete Desktop Client 
The Undelete Desktop Client, which is used  with Undelete Server Edition, allows you (or more 

importantly, your users) to find and recover deleted files from remote Recovery Bins, such as those on a 

file server. The Undelete Desktop Client operates similarly to the Recovery Bin interface in Undelete 

Professional Edition, except it only “sees” Recovery Bins on remote systems. It does not have a “local” 

Recovery Bin where deleted files are stored. Users are only shown and allowed to recover files on shared 

network drives for which they have sufficient ownership or system privileges. 

The Undelete Desktop Client saves time and trouble for System Administrators and Help Desk personnel 

by enabling users to recover their own deleted files from remote file servers. 

See Chapter 2 for more information about the Undelete Desktop Client. 

Emergency Undelete 
Emergency Undelete is a separate utility used to recover accidentally deleted files before installing the full 

Undelete product. Since installing software on a computer can overwrite deleted files and make them 

unrecoverable, Emergency Undelete runs directly from a CD-ROM or floppy disk without any installation. 

See Chapter 3 for more information about Emergency Undelete. 

Undelete Editions 
Here is a brief description of the different Undelete editions. The tables in Appendix B show additional 

details. 

Undelete Server Edition  

Undelete Server Edition enables you to find and recover files deleted on the server where Undelete is 

installed as well as mapped shares on remote computers on your network (if they also have Undelete Server 

Edition installed). Undelete Server Edition can also connect directly to remote machines running Undelete 

Server or Professional, allowing you to access Undelete on the remote computer as if you were sitting in 

front of the machine. Undelete Server Edition also supports the Undelete Desktop Client, which allows 

access to Recovery Bins on remote computers.  
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Undelete Professional Edition 

Like Undelete Server Edition, the Professional Edition can recover files from the computer where it is 

installed, and it can also recover files from computers that have Undelete Server Edition installed. 

Undelete Home Edition 

Undelete Home Edition can undelete and recover files deleted from your local computer, but it does not 

support the Undelete networking features.  

Important Points about Undelete 
Here are several important points about using Undelete: 

 When you install Undelete, it will take the place of any other file recovery utilities currently installed 

on your computer. This includes the Windows Recycle Bin as well as third party products that perform 

similar functions. 

 Where security is of concern, the Recovery Bin Properties can be set to completely erase files that are 

deleted from the Recovery Bin, using the SecureDelete option. 

 Long filenames might be shortened to the DOS 8.3 file naming convention when files are deleted from 

the Windows command prompt and recovered with Undelete. 

 Undelete Server Edition cannot recover files on computers running the Home Edition of Undelete. It 

can, however, recover files on computers running Undelete Professional or Undelete Server.  

About Diskeeper Corporation 
Diskeeper Corporation, founded by its Chairman and CEO Craig Jensen, was incorporated in 1981. In 

1986, Diskeeper Corporation’s flagship product, Diskeeper for VAX/VMS was introduced, establishing 

Diskeeper Corporation as the leader in defragmentation products for the corporate marketplace. Since then, 

the company has become established as a leader in OpenVMS and Windows performance and system 

management solutions. 

Part of our company’s corporate purpose is to help Data Center Managers solve performance and system 

management problems. Superior technical capability coupled with meticulous market research fueled rapid 

growth for Diskeeper Corporation, and resulted in a high degree of customer satisfaction. 

Diskeeper Corporation has grown from five people in 1986 to more than a hundred today, with 

headquarters in California and a worldwide distribution network. The expansion of the company and the 

popularity of its products demonstrate a successful implementation of the company’s purpose and the 

degree of technical and administrative capability that backs it up. 

Other Important Products 
Diskeeper Corporation is known throughout the computer industry for its focused development of system 

management tools. If you are running any current Windows operating system (Windows 95 through 

Windows Server 2003), you should also have: 

Diskeeper automatic disk defragmenter for Windows 

Diskeeper is the most recommended network defragmenter in the world and independent lab tests confirm 

that it maximizes performance, lowers operating costs, and raises system productivity.  
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Modern operating systems fragment files as they are written to the disk, resulting in degraded performance. 

Diskeeper completely handles the problem without adding to a system administrator’s workload. That’s 

why Diskeeper is considered an absolute necessity by top IT professionals worldwide. Get the system 

performance you deserve with Diskeeper, available from your local reseller or directly from Diskeeper 

Corporation. 

Sitekeeper® System Management Software 

Get at-a-glance updates on every software version, build, update and patch. Also see detailed hardware 

information including processor speed, RAM, hard drive size, logical free space and asset management tags 

from the BIOS and motherboard. Install/uninstall programs with a few clicks of the mouse, using Diskeeper 

Corporation’s PushInstall feature. 

You can visit the Diskeeper Corporation website at: 

diskeeper.com

 

Or visit Diskeeper Corporation Europe at: 

diskeepereurope.com/
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C h a p t e r  1  

Installing Undelete 

 

This chapter explains how to install Undelete and provides important information you should know after 

the installation. 

Before the Installation 
 

Windows Versions Supported 
Undelete is supported on the Intel x86 platform (including Pentium and compatible CPUs from other 

manufacturers), running the Windows 2000, Windows XP and Windows Server 2003 operating systems. 

Note that Windows 2000 systems must be running Service Pack 3 or higher. 

The different editions of Undelete support the following operating systems: 

 

Undelete Edition Supported Operating System 

Undelete Server Edition 

Windows 2000 Server 

Windows 2000 Professional 

Windows XP Professional 

Windows XP Tablet PC 

Windows Server 2003 (all 

editions) 

Undelete Professional Edition 

Windows 2000 Professional 

Windows XP Professional 

Windows XP Tablet PC 

Windows XP Media Center 

Windows XP Home Edition1

 

                                                           

1 Networking features are not available when running Undelete Professional Edition on Windows XP Home Edition. 
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Undelete Edition Supported Operating System 

Undelete Desktop Client 

Windows 2000 Professional 

Windows XP Professional

Windows XP Tablet PC 

Undelete Home Edition 

Windows 2000 Professional 

Windows XP Professional 

Windows XP Tablet PC 

Windows XP Media Center 

Windows XP Home Edition 

 

File Systems Supported 
Undelete supports the NTFS and 16 and 32-bit FAT file systems, but the 12-bit FAT file system is not 

supported. (The 12-bit FAT file system is used on FAT volumes smaller than 16 megabytes in size, such as 

1.44 MB floppy diskettes.)  

Disks Supported 
Undelete supports a wide range of SCSI and IDE disks, including: 

 Primary Partitions 

 Extended Partitions 

 Logical Drives 

 Volume Sets 

 Mirror Sets 

 RAID arrays 

 Removable disks (such as ZIP drives and many memory cards) 

Resource Requirements 
The disk space requirements for Undelete Professional Edition and Undelete Desktop Client are about 4 

megabytes or less.  

Undelete Server Edition requires up to 35 megabytes of disk space. 

After Undelete is installed, a Recovery Bin is created by default on each disk volume detected on your 

computer. Although these Recovery Bins initially use no disk space, they will eventually grow as files are 

deleted. The default size limit for these Recovery Bins is 20% of the disk volume, but this can be changed 

easily with the Recovery Bin Properties option on the Tools menu. 
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Installation Overview 
Undelete is installed from a CD-ROM or from a downloaded file. The Undelete installation program: 

 Confirms that you have Administrator privileges. 

 Determines which version of Windows you are running. 

 Checks for sufficient space on the disk for the installation. 

 Recognizes and will install over previous versions of Undelete. 

 Copies the Undelete files to the destination directories. 

 Updates the Windows registry. 

 Replaces the Windows Recycle Bin icon on your desktop with the Recovery Bin Icon, but leaves the 

Recycle Bin and its contents in the directory structure on your computer. (Note that Undelete Desktop 

Client does not replace the Recycle Bin icon, but instead adds an Undelete Desktop Client icon to your 

users’ desktops.) 

 Initializes the Undelete service. 

Note: To complete the installation, it is necessary to restart your computer. This starts the Undelete driver, 

which intercepts file deletion requests and redirects the deletion operations, causing “deleted” files to be 

placed in the Undelete Recovery Bin. A restart is not necessary when installing the Undelete Desktop 

Client. 

 

Installation Procedure 
The Undelete package includes two separate programs—Undelete and Emergency Undelete. The full 

Undelete product includes both the Recovery Bin feature and the Search Disk feature. 

Emergency Undelete is a compact version of Search Disk, intended to run as a separate program in 

situations where any write activity on a disk could endanger the recovery of previously deleted files. 

Emergency Undelete requires no installation. It is run directly from a floppy disk or CD-ROM.  

Installing Undelete from CD-ROM 
To install Undelete from CD-ROM, follow these steps while logged on to an account that is a member of 

the Administrators Group: 

1. Insert the Undelete CD-ROM into the appropriate drive on your computer. 

2. The Windows AutoPlay feature automatically starts the installation.  Just follow the directions 

displayed on your screen. 

If you have disabled the AutoPlay feature, use Windows Explorer to locate and double-click the 

Setup.exe file in the root-level folder on the CD-ROM and follow the directions displayed. 

Installing Undelete from a Downloaded File 
To install Undelete from a downloaded file, follow these steps while logged on to an account that is a 

member of the Administrators Group: 
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1. After downloading the Undelete package to a temporary location on your computer, double-click the 

self-extracting executable file you downloaded. 

2. You will be prompted for a temporary location to extract the Undelete files into.  You can accept the 

default location shown or click Browse to select another location.  

3. Follow the instructions displayed to install Undelete or to create an Emergency Undelete floppy disk. 

After the Installation 
After installing Undelete, there are still several steps to consider. 

Check for Update   
The first time you run Undelete, it automatically checks to see if a more recent version of Undelete is 

available. If so, you are given the option to download and install the newer version. When the download 

screen is displayed, click Run this program from its current location to begin installing the update. Or, 

click Save this program to disk to save the Undelete update installation package on your computer for 

later installation. (To install an update stored on your computer in this manner, simply double-click the file 

you downloaded and follow the instructions displayed.) 

You can check for Undelete updates any time you want. Use the Check for update option in the Help 

menu to see if a newer version of Undelete is available. 

About Windows Service Packs 
There is typically no need to upgrade Undelete each time you install a new Windows Service Pack upgrade. 

Important Note: Windows XP Service Pack 2 (SP2) establishes default security settings that can prevent 

Undelete Server Edition from communicating with Undelete computers throughout your network. Be sure 

to visit www.undelete.com/sp2 for the latest information about configuring your Windows XP SP2 

computers to run Undelete. 

 

Registering Undelete 
After the Undelete installation is complete, you may be given the option to register your purchase. You can 

also register Undelete at the Diskeeper Corporation Web site at www.undelete.com/register. Both 

methods provide a fast, efficient way to register Undelete. 

Be sure to register your Undelete purchase to receive the free 90 days of telephone support included with 

Undelete. 

A Note About Repairing Your Windows System 
Performing an emergency repair or reinstallation of a Windows system can possibly change or disable 

certain system information or services. For this reason, it may be necessary to reinstall Undelete after 

repairing your Windows system. 

A Note About Firewalls 
As a normal part of its operation, Undelete acts as a server on your network. If you are running a hardware 

or software firewall, you may see messages indicating Undelete is trying to act as a server. These messages 

are expected; you can safely allow these events.  
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You may also be notified that Undelete is trying to access the Internet. It is important to note that Undelete 

does not access the Internet (except when you specifically use the Check for Updates feature), but it does 

use Windows mechanisms that may trigger these alerts from your firewall. Again, these messages are 

expected and you can safely allow the events. 

About the Undelete Service 
Undelete is primarily designed as a “Set It and Forget It”® file recovery system. In order to accomplish this 

goal, it creates a Windows service. The service allows Undelete to run in the background while other 

applications are running. 

After installation, the Undelete service starts automatically each time your Windows system is started. The 

Undelete service runs all the time, whether or not Undelete is in use. This service consumes negligible 

system resources. It must be running for Undelete to save deleted files in the Recovery Bin and for the 

Undelete user interface to operate correctly.  

Uninstalling Undelete 
Follow these steps to remove Undelete from your computer: 

1. From Control Panel, double-click Add/Remove Programs. 

2. Click the Install/Uninstall tab. 

3. Highlight Undelete. 

4. Click the Add/Remove button. This removes the Undelete service, files, Program Group, and registry 

entries from your computer. 

5. Restart your computer. Undelete will not be removed completely until you restart. 

6. As a final step, manually delete the Undelete installation directory if it exists. 

Important Note: It may be necessary to reboot your computer after uninstalling Undelete in order to fully 

restore the native Windows Recycle Bin function. 

 

Installing the Undelete Desktop Client 
Undelete Server Edition also supports the Undelete Desktop Client, a special version of Undelete which 

allows network users to recover their own deleted files from a file server. This allows users to “help 

themselves” when they accidentally delete files and frees up System Administrators and Help Desk 

technicians for more important tasks. 

In many cases, the Undelete Desktop Client will be installed using the PushInstall® feature described in 

Using PushInstall on page 49. PushInstall allows you to easily install the Undelete Desktop Client on one 

or a thousand computers with a few mouse clicks. 

To install the Undelete Desktop Client on a single computer, follow the instructions earlier in this chapter 

for installing Undelete. 
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C h a p t e r  2  

Using Undelete 

 

This chapter describes the various features offered by Undelete and explains their operation. 

Opening the Undelete Interface  
To open the Undelete interface and access its various features, double-click the Recovery Bin icon on your 

desktop. 

Here is an example of the Recovery Bin display, which is the main view of Undelete: 

 

Menus

Toolbar 

Tree View 
Pane 

Status Bar 

File 
Information 

Pane 

The Recovery Bin interface contains pull-down menus and a toolbar. Many of the functions offered are the 

same on the menus and toolbar. A tree view of available disk volumes and folders is also displayed, plus a 

list of files that were removed from the selected volume or folder, but have been saved in the Recovery Bin.  
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Here are descriptions of the various parts of the Recovery Bin interface: 

Tree View Pane 
This section of the Recovery Bin display shows a tree view of the available disk volumes and folders. Click 

on the icon of a disk volume to view a list of the files in the Recovery Bin that were “deleted” from the root 

directory of that volume, or click on one of the folder icons to view the “deleted” files from that folder. 

As with Windows Explorer, click on a “+” symbol next to the icon to expand a tree (show subfolders), or 

click the “-” symbol to collapse it (hide subfolders). 

Undelete Server Edition and Undelete Professional Edition can also display mapped drives on remote 

computers, if the remote machine is also running Undelete Server or Professional. (The Undelete Desktop 

Client only shows mapped network drives—local drives are not shown.) 

 This icon indicates mapped file shares on computers that are running Undelete Server Edition. You can 

view the files deleted from these shares by double-clicking the icon and navigating to the deleted files. 

 This icon indicates mapped file shares on computers that are not running Undelete Server Edition, or 

the server is currently unavailable. You can hide shares displaying this icon by using the Disconnect 

Network Folder  option in the Undelete toolbar. 

In some cases, neither of these icons are displayed. If so, use the Connect Network Folder option on the 

Undelete toolbar  and enter login credentials as prompted to connect to your network shares. You can 

also use the Connect Network Folder option to connect to a shared folder that you have not already mapped 

in Windows Explorer. 

If you do not know from what folder a file was deleted, you can search for it, using the Search Recovery 

Bin feature. This feature can be accessed from the toolbar or from the File menu. 

File Information Pane 
The file information pane shows information about the files in the Recovery Bin.  

It is also where you select specific files you want to recover. To select more than one file, hold the <Ctrl> 

key while clicking on the names of the files you want to recover. Or, you can hold the <Shift> key to select 

a continuous list of files. 

Here is the information shown in the file information pane: 

Name 

This column of the display shows the original filename and extension of the files saved in the various 

\RecoveryBin\ directory folders on your computer. Right-click a filename as a shortcut to Recover or 

Delete it. 

Click on the title bar at the top of this column to sort the files by name in forward or reverse alphabetical 

order. 

Copies 

This column in the display shows the number copies of the deleted file in the Recovery Bin, or in the case 

of Microsoft Office files, this column shows the number versions of the file in the Recovery Bin.  

Click on the column heading to sort the files by number of copies in ascending or descending numerical 

order.  
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 Tip: Right-click a file in the file information pane and select the View Copies option to see a listing of the 

different copies of the file that have been saved by Undelete. Then, right-click one of the versions of the 

file shown in the listing and select options to recover, delete, or open the file. 

Size 

This column of the display shows the size of the files either stored in the Recovery Bin or detected by the 

Search Disk feature. 

Click on the title bar at the top of this column to sort the files by size in forward or reverse order. 

Date Deleted 

This column of the Recovery Bin display shows the date a file was “deleted” and moved to the Recovery 

Bin. 

Click on the title bar at the top of this column to sort the files by the date they were deleted, shown 

alternately in forward or reverse date order. 

Date Modified 

This column of the Recovery Bin display shows the date a file was modified. 

Click on the title bar at the top of this column to sort the files by the date they were modified, shown 

alternately in forward or reverse date order. 

Deleted By 

This column of the Recovery Bin display shows the names of the accounts used to delete files.  

Click on the title bar at the top of this column to sort this column alphabetically, shown alternately in 

forward or reverse date order. 

Note that the name reported in the "Deleted by" column is the name of the account that was used to 

authorize the file deletion. In the case of a local file delete, this is the account under which you logged in, 

shown as the name of the local machine, followed by the name of the account used on that machine. If you 

are logged on using a domain account, the name shown will be the name of the domain followed by the 

domain account name. 

When files are deleted from a remote machine via a mapped share, things are a bit more complicated. In 

this case, the account that is used to authorize the deletion is the account that authorized the mapping of the 

share on the machine to which the disk is directly attached. Thus, if you log onto LOCAL1\YourName, map 

a share on SERVER1 using your DOMAIN1\YourName account, and delete a file on the share, the 

"Deleted by" name is "DOMAIN1\YourName" in the Recovery Bin on SERVER1. This is because 

SERVER1 does not “know” anything about the LOCAL1\YourName local account—it only knows about, 

and can get information for, the DOMAIN1\YourName account. 

Owned By 

This section of the Recovery Bin display shows who, if anyone, owned the deleted file. 

Click on the title bar in this section to sort the files by the names of their owners, shown alternately in 

forward or reverse alphabetical order. 

Toolbar 
The Undelete toolbar has icons for the most common Undelete tasks. Each of these icons and tasks are 

described in their respective sections later in this chapter. Note that some of these toolbar icons are not 

available in Undelete Home Edition or the Undelete Desktop Client. 
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These options are available from the Undelete toolbar: 

—View Copies—See a listing of the copies of the selected file saved by the Version Protection for 

Microsoft Office files feature 

—Recover selected—Retrieve deleted files from the Recovery Bin 

—Delete selected—Remove selected files from the Recovery Bin 

—Empty Recovery Bin—Remove all the files from the Recovery Bin 

—Search Recovery Bin—Locate files in the Recovery Bin 

— Search Disk—Find and recover files that have really been deleted (Undelete Server, Professional 

and Home editions only) 

— Recovery Bin Exclusion List—Specify which files you don’t want to be saved in the Recovery 

Bin (Not available in the Undelete Desktop Client) 

—Recovery Bin Properties—Change a variety of Recovery Bin settings (Not available in the 

Undelete Desktop Client) 

—Connect to a Network Folder—Display Recovery Bins from remote computers in the Tree View 

pane (Not available in Undelete Home Edition) 

—Disconnect from a Network Folder—Remove Recovery Bins from remote computers from the 

Tree View pane (Not available in Undelete Home Edition) 

—Connect to a Remote Computer—Connect to the Recovery Bin on a remote computer (Undelete 

Server Edition only) 

—Help Topics—View the Undelete Help system 

—Visit Diskeeper Corporation—View information about Diskeeper Corporation and access the 

Diskeeper Corporation web site 

The toolbar buttons provide a convenient way to access the most common Undelete features, which are 

described in this chapter. 
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Menus 
The Undelete menus have these options: 

 

 

File Menu 

Recover Selected…—Retrieve deleted files from the Recovery Bin  

Delete Selected—Remove selected files from the Recovery Bin  

Empty Recovery Bin—Remove all the files from the Recovery Bin  

View Copies—See a listing of the copies of the selected file saved by the Version Protection for Microsoft 

Office files feature 

Open—Open the selected file with the default application associated with the file extension of the file 

Search Recovery Bin—Locate files in the Recovery Bin  

Search Disk—Find and recover files that have really been deleted (Undelete Server, Professional and 

Home editions only) 

Close—Close the Recovery Bin  

 

View Menu 

Refresh—Update the Recovery Bin display to show any changes since the Recovery Bin was opened 

Show Orientation on launch—Show the Undelete Orientation each time Undelete is opened 

Show Delete Files—Show files that have been deleted and are now in the Undelete Recovery Bin 

Show File Versions—Show files the Version Protection for Microsoft Office files feature has saved in the 

Recovery Bin 

Show Both—Show deleted files and files saved by the Version Protection for Microsoft Office file feature 

in the Recovery Bin 

 

Tools Menu 

Recovery Bin Exclusion List…—Specify which files you don’t want to be saved in the Recovery Bin 

(Not available in the Undelete Desktop Client) 

Recovery Bin Properties…—Change a variety of Recovery Bin settings (Not available in the Undelete 

Desktop Client) 

Connect Network Folder…—Display Recovery Bins from remote computers in the Tree View pane (Not 

available in Undelete Home Edition) 

Disconnect Network Folder …—Remove Recovery Bins from remote computers from the Tree View 

pane (Not available in Undelete Home Edition) 

Connect to Remote Computer…—Connect to the Recovery Bin on a remote computer (Undelete Server 

Edition only) 
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Help Menu 

Help Topics—View the Undelete Help system. 

About Undelete—Show the version number and other information about Undelete. 

Check for update—Open a browser window and automatically check the Diskeeper Corporation website 

to see if an update is available for the version of Undelete installed.  

Register Undelete—Open a browser window and register your purchase of Undelete. 

Any Undelete menu options needing additional explanation are described in further detail later in this 

chapter. 

Status Bar 
This section of the Recovery Bin display shows information about the Recovery Bin. 

When no files are selected, the Status Bar shows the number of files in the Recovery Bin, their total size, 

and the percentage of the Recovery Bin size used. Note that the percentage of the Recovery Bin in use 

figure indicates the total Recovery Bin space, which can include more than one Recovery Bin if you have 

specified Recovery Bins on more than one disk volume. For this reason, there is a possibility that a small 

Recovery Bin on one volume could be full while a large Recovery Bin on another volume could be nearly 

empty, and the percentage of the total Recovery Bin size used could be as low as 1 or 2 percent. 

When one or more files are selected, the Status Bar shows the number of files selected and their total size. 

Using the Recovery Bin 
With Undelete, deleted files aren’t really deleted—the deletion request is intercepted by Undelete and the 

deleted files are actually stored in another location, called the Recovery Bin—so recovering these deleted 

files is only a few mouse clicks away.  

To view the Recovery Bin display, double-click the Recovery Bin icon on your desktop. The files shown in 

the Recovery Bin display are files that have been deleted by any of a variety of methods, including 

Windows Explorer, File Manager, or any other application capable of deleting files. It also includes files 

deleted via the Windows command prompt. 

You can have more than one Recovery Bin on your computer. By using the Recovery Bin Properties 

option, you can specify individual Recovery Bins for each disk volume, or choose a single location to 

where “deleted” files are moved (known as a “Common Recovery Bin”).  

Undelete Server Edition creates Recovery Bins on your file servers, and your users can access and recover 

their own deleted files from these networked servers using either Undelete Professional Edition or Undelete 

Desktop Client. 

Note: Using a Common Recovery Bin on a network server will cause all the deleted files on the server to 

be copied into a single location. If a large number of deletions take place on the network, this can add 

considerable I/O overhead. This overhead is apparent not only on the disk where the Common Recovery 

Bin is located, but also on the disk from where the files are being copied. For this reason, a Common 

Recovery Bin is not recommended on a busy server. Instead, enable the Recovery Bin individually on each 

drive. 
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Recovering Files 

Use the Recover selected button  or the Recover Selected… option on the File menu to recover one 

or more selected files from the Recovery Bin. When you use this option, the selected files are normally 

written back to the location from where they were “deleted”. If the directory folder in which the selected 

files were stored has also been “deleted”, the folder is also recovered. You also have the option to recover 

the files to another location of your choice. 

Note: You must have adequate permissions and ownership of a file in order to recover it from the Recovery 

Bin. 

When you use this option, a dialog box similar to this is displayed: 

 

Click OK to restore the selected files to the location from which they were originally “deleted.” If the 

directory folder in which the selected files were stored has also been “deleted,” the folder is also recovered.  

To restore the selected files to a different location, navigate to the disk and directory folder where you want 

to save the restored file and click OK. To return to the main Recovery Bin display without recovering the 

files, click Cancel. 

Important Points about the Recovery Bin 
Here are some important points to remember about the Recovery Bin: 

 You can right-click a file in the Recovery Bin to perform a variety of functions, including: 
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o Recover or delete the file from the Recovery Bin. 

o Add the file to the Recovery Bin Exclusion List. (Note that the Recovery Bin Exclusion List only 

applies to local files. You cannot right-click to exclude files from Recovery Bins on shared 

network folders.) You can add the file to the Exclusion List in one of three ways: 

a) By filename—all the files on the system with that name and extension will be excluded. 

b) By file type—all the files of that type on the system with that file extension will be excluded.  

c) By directory—all the files in that directory folder on the volume will be excluded. 

o View copies of the file saved by the Version Protection for Microsoft Office files feature. 

o Open the file, with either the default application associated with that file type, or with the 

application you choose. 

 In keeping with NTFS file security, you must have sufficient file permissions and ownership to recover 

a file from the Recovery Bin. 

 You can adjust the size of the Recovery Bin by using the Recovery Bin Properties option. 

 You can “drag and drop” files from your desktop or from Windows Explorer into the Recovery Bin 

icon on your desktop, but not into the main Recovery Bin interface.  

 By default, when the Recovery Bin reaches the size you have specified, it is automatically partially 

purged to make room for newly deleted files. For this reason, files that were once stored in the 

Recovery Bin can become no longer available from the Recovery Bin. (Although they still may be 

recoverable with the Search Disk feature). This default can be changed with the Recovery Bin 

Properties option, but changing this default can cause the Recovery Bin to fill completely, and 

additional file "deletions" will not be moved to the Recovery Bin. 

 If a file of the same name exists in the “deleted” file’s previous location, the “deleted” file is 

recovered, but with a "version number" added before the file extension. Because of this capability, 

multiple files of the same name can be recovered. 

 You can set the Recovery Bin properties by right-clicking the Recovery Bin icon on your desktop. 

Searching the Recovery Bin 
If you do not know the folder where a particular deleted file was located, the Search Recovery Bin feature 

can come in handy. You can search for deleted files by name and location, by date created or deleted, and 

by owner. These search methods can be combined, if desired. 

Searching by Name and Location 

Use the Search Recovery Bin button  or the Search Recovery Bin option in the File menu and click 

the Name & Location tab to see a display similar to this: 
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The various controls and components of this dialog box are described below: 

Name 

Use this section of the Recovery Bin Search display to specify the name of the deleted file you want to find. 

You can use wildcard characters (* and ?) in this section of the display. 

You must provide a filename or wildcard sequence (such as *.doc or *.*) as a search pattern to use for 

finding files. 

Location 

Use this section of the Recovery Bin Search display to specify the disk volume and directory folder of the 

file you want to undelete. 

Use the Browse button to navigate to different drives and folders on your computer to speed up your search 

for the correct path. 

Browse 

Click this button to display the tree view pane and navigate to the path of the disk volume and directory 

folder where the file you want to undelete resided immediately before it was deleted. 

Remember, with Undelete Server Edition, you can also specify disk volumes and folders on remote 

computers, as long as the remote computers are also running a comparable version of Undelete Server. 

Include subfolders in search 

When this option is enabled, any subfolders below the specified directory folder will be searched for files 

that match the specified search pattern. 

Search 

Click this button to find any previously deleted files that match the file name (with optional wildcards) in 

the Name box and the location specified in the Location box.  
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After a deleted file has been found, it can be recovered, removed from the Recovery Bin, or added to the 

Exclusion List by right-clicking on the filename and selecting the appropriate menu item. (Note that the 

Recovery Bin Exclusion List only applies to local files. You cannot right-click to exclude files from 

Recovery Bins on shared network folders.) 

Stop 

Click this button to stop an ongoing file search. 

Close 

Click this button to close the Search Recovery Bin display and return to the main Recovery Bin display. 

Recoverable Files Section 
This section of the Recovery Bin Search dialog shows information about any files found during the search: 

Name 

This column in the display shows the original filename and extension of the detected files. 

In the case of the Recovery Bin, this section shows the names of the files stored in the various 

\RecoveryBin\ directory folders on your computer.  

 Tip: Right-click the filename as a shortcut to open, recover, delete, or view copies of the selected file. You 

can  also add the file to the Recovery Bin Exclusion List. 

Click on the column heading to sort the files by name in forward or reverse alphabetical order. 

Copies 

This column in the display shows the number copies of the deleted file in the Recovery Bin, or in the case 

of Microsoft Office files, this column shows the number versions of the file in the Recovery Bin.  

Click on the column heading to sort the files by number of copies in ascending or descending numerical 

order. 

Size 

This column in the display shows the size of the deleted files stored in the Recovery Bin. 

Click on the column heading to sort the files by size in forward or reverse order. 

Date Deleted 

This column in the display shows the date a file was “deleted” and moved to the Recovery Bin. 

Click on the column heading to sort the files by the date they were deleted, shown alternately in forward or 

reverse date order. 

Date Created 

This column in the display shows the date a file was created. 

Click on the column heading to sort the files by the date they were created, shown alternately in forward or 

reverse date order. 

Deleted By 

This column in the display shows the names of the accounts used to delete files.  
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Click on the column heading to sort this column alphabetically, shown alternately in forward or reverse 

date order. 

Note that the name reported in the “Deleted by” column is the name of the account that was used to 

authorize the file deletion. In the case of a local file delete, this is the account under which you logged in, 

shown as the name of the local machine, followed by the name of the account used on that machine. If you 

are logged on using a domain account, the name shown will be the name of the domain followed by the 

domain account name. 

When files are deleted from a remote machine via a mapped share, things are a bit more complicated. In 

this case, the account shown is the account that authorized the mapping of the share on the machine to 

which the disk is directly attached. Thus, if you log onto LOCAL1\YourName, map a share on SERVER1 

using your DOMAIN1\YourName account, and delete a file on the share, the “Deleted by” name is 

“DOMAIN1\YourName” in the Recovery Bin on SERVER1. This is because SERVER1 does not “know” 

anything about the LOCAL1\YourName local account—it only knows about, and can get information for, 

the DOMAIN1\YourName account. 

Owned By 

This column in the display shows who, if anyone, owned the deleted file. 

Click on the title bar in this section to sort the files by the names of their owners, shown alternately in 

forward or reverse alphabetical order. 

Original Location 

This column in the display shows the disk volume and directory folder where a file was originally located. 

When you recover a file, it will be placed in its original location unless you specify otherwise. 

Click on the column heading to sort the files by original location in forward or reverse alphabetical order. 

This section shows the location where the “deleted” file was originally located before being moved to the 

Recovery Bin. 

Status Bar 

This section of the display shows information about the Recovery Bin. 

When no files are selected, the Status Bar shows the number of files in the Recovery Bin, their total size, 

and the percentage of the Recovery Bin size used. Note that the percentage of the Recovery Bin in use 

figure indicates the total Recovery Bin space, which can include more than one Recovery Bin if you have 

specified Recovery Bins on more than one disk volume. For this reason, there is a possibility that a small 

Recovery Bin on one volume could be full while a large Recovery Bin on another volume could be nearly 

empty, and the percentage of the total Recovery Bin size used could be as low as 1 or 2 percent. 

When one or more files are selected, the Status Bar shows the number of files selected and their total size. 

Searching by Date 

Use the Search Recovery Bin button  or the Search Recovery Bin option in the File menu and click 

the Date tab to see a display similar to this: 
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Follow these steps to search the Recovery Bin by date: 

1. Select the Include the date that the files were created or deleted in this search check box. 

2. In your deleted file search, you can specify either the date the files were created, or when they were 

deleted. Make your selection accordingly in the Search by: drop-down list box. 

3. You can specify a date range two different ways, depending on whether you click on in the last or on 

between: 

 By specifying how many days ago the file may have been created or deleted, or 

 By specifying a starting and ending date. 

4. After entering the date range, click Search. This starts the search for the deleted file(s). 

5. After a deleted file has been found, it can be opened, recovered, removed from the Recovery Bin, or 

added to the Exclusion List by right-clicking on the filename and selecting the appropriate menu item. 

(Note that the Recovery Bin Exclusion List only applies to local files. You cannot right-click to 

exclude files from Recovery Bins on shared network folders.) 

6. Click Close to close the Search Recovery Bin dialog box and to return to main Undelete display. 

The various controls and components of the Search by Date dialog box are described below: 

Include the Date... Check Box 

Select the Include the date that the files were created or deleted in this search check box if you want to 

search the Recovery Bin for files by date. Keep in mind you can use this search criteria with others (such as 

the file location or who deleted the file) to narrow down your search. 

Search By 

Select files Created if you want to specify when the files you are searching for were created, or select files 

Deleted if you want to specify when the files were deleted. 
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In the last ‘N’ days 

Enter how many days you want to go back in your search for deleted files. For example, you could search 

for files that were deleted (or created) in the last 5 days. Type the number of days directly into the box, or 

use the up or down arrow at the side of the box to increase or decrease the number shown. 

Between … And 

To search the Recovery Bin for files created or deleted within a given date range, enter the starting date in 

the top box and the ending date in the bottom box. Enter both dates in the correct date format for your 

system. Instead of typing in the date, you can click the down arrow symbol at the side of the box and a 

calendar will display, where you can browse to the desired date and click on it. (You can also change the 

displayed year or month by clicking on it and then making your selection.) 

Searching by Owner/Deleted By 

Use the Search Recovery Bin button  or the Search Recovery Bin option in the File menu and click 

the Owner/Deleted by tab to see a display similar to this: 

 

Note that file ownership only applies to NTFS volumes. The owner of a file is the user account, or the 

group account that is registered with NTFS as having ownership of the file. 

Follow these steps to search the Recovery Bin by owner: 

1. Click the Owner/Deleted by tab. 

2. Click the Include the name of the user who owned the file check box to enable that option and enter 

the username of the person who last owned the deleted file you are looking for, and/or: 

3. Click the Include the name of the user who deleted the file check box to enable that option and enter 

the username of the person who deleted the file you are looking for. 
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4. Click Search. This starts the search for the deleted file(s).  

5. After a deleted file has been found, it can be opened, recovered, removed from the Recovery Bin, or 

added to the Exclusion List by right-clicking on the filename and selecting the appropriate menu item. 

(Note that the Recovery Bin Exclusion List only applies to local files. You cannot right-click to 

exclude files from Recovery Bins on shared network folders.) 

6. Click Close to close the Recovery Bin Search dialog box and to return to the main Undelete display. 

View Copies 
Use the View Copies option on the File menu to see a either a listing of the copies of a deleted file in the 

Recovery Bin, or in the case of Microsoft Office files, to see a list of the individual versions of the file.  

 Tip: Right-click the file in the Recovery Bin and select View Copies.  

When you use this option, a separate window is opened and a listing of all the copies (older versions) of the 

selected file are shown in a window similar to this: 
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Select a file and right-click it to see a menu of the options available: 

 

From the menu displayed, you can choose from these options: 

a. Recover the selected version of the file (and save it to the location of your choice) 

b. Delete that version of the file 

c. Open that version of the file with the default application for that file type 

d. Open the file with the application of your choice 

Opening a File 
You can open a file directly from the Undelete Recovery Bin. This offers a useful way to see if the 

recovered file is indeed the one you were looking for. To open a file in the Recovery Bin, simply right-click 

on the filename and select between these options: 

Open—Opens the file with the application set as the default for that file type. 

Open With—Allows you to specify the application you want to use to open the file.  

 Tip: Simply double-click a file to open it using the default application for that file type. 

Search Disk 

Use the Search Disk button  or the Search Disk option in the File menu to recover files that have 

really been deleted.  

Important Notes:  

1. The Search Disk feature cannot recover files that have been overwritten by other files. As a result, 

there may be cases where a file is not recoverable. 
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2. In keeping with NTFS file security requirements, you must be a member of the Administrators group 

to undelete files directly from the disk.  

3. This option is not available in the Undelete Desktop Client. 

When you delete a file in Windows, the system does not remove it from the disk, but instead marks the 

space the file occupies as free space. When you search for and recover a file with the Search Disk feature, a 

new file is created and the old file data is then copied into the new file. We recommend that you recover the 

file to a volume other than the one from which the file was deleted. This prevents the old file data from 

being overwritten by the new file, which would render it unrecoverable. 

The Search Disk feature allows you to recover files that have really been deleted, such as files purged from 

the Recovery Bin, or files that were deleted when the Recovery Bin was not enabled. This feature can also 

be used to recover files from volumes or directory folders that have been excluded from Recovery Bin 

processing. Note that this operation can only succeed if the space occupied by the file that is to be 

recovered has not been overwritten during the time it was marked as free space. 

Important Points about the Search Disk Feature 
Here are some important points about using the Search Disk feature: 

 For best results in recovering files that have really been deleted, use the Search Disk feature as soon as 

possible after deleting the file. This increases the chances that your file recovery will be successful. If a 

file is overwritten by other file activity on the disk, Undelete will be unable to recover it. 

 In keeping with NTFS file security, you must be a member of the Administrators group and have 

sufficient file permissions and ownership to recover a file directly from the disk.  

Note: A file that is recovered with the Search Disk feature will default to the security attributes of the 

user (Administrator) doing the file recovery. 

 The Search Disk feature can recover files that have been purged from the Recovery Bin (using the 

Empty Recovery Bin button or menu option), files deleted from directory folders that have been 

excluded from Recovery Bin processing (using the Recovery Bin Exclusion List button or menu 

option), or files deleted from drives on which Recovery Bin processing is disabled (using the Recovery 

Bin Properties option). 

 The Search Disk feature can even undelete files that were deleted before you installed Undelete! Note, 

however, that simply installing an application (including Undelete) can overwrite the same files you 

want to recover. For this reason, Emergency Undelete is the recommended tool for recovering files that 

have been accidentally deleted before you install Undelete. 

 When a file is really deleted, the space it occupied on the volume is marked as available free space, but 

the file data still remains on the volume until the space is used to store another file. Therefore, there are 

cases where the Search Disk feature may not be able to recover the deleted file, or may only be able to 

recover a portion of the file. As a general rule, the more disk activity that occurs after a file is deleted, 

the higher the chances are that new or modified files will overwrite the file information. 

 When a deleted file has been partially overwritten with new data, there is a possibility that the Search 

Disk feature may report successfully undeleting the file, when in fact a portion of the file has been 

overwritten and is thus corrupt. 

 On NTFS volumes, only Small and Large file types2 are eligible for being undeleted directly from the 

disk. 

                                                           

2 In the NTFS file system, four file types exist. Small files are contained entirely within a single record in the Master File Table 

(MFT). Large files are stored elsewhere on the disk, but the index information pertaining to the file, including the locations of the 

various fragments of the file, is contained within a single record in the MFT. Huge files are similar to Large files, but they have 

enough additional file record information (such as additional file security information, or a large number of file fragment locations) 

 22



Operation 

 Zero-length files are not shown (or made available for recovery) when you search a disk with this 

feature. 

 When undeleting fragmented files on FAT volumes, the Search Disk feature may only be able to 

undelete the first contiguous portion of the file. A partial recovery of a text file can be better than none, 

but the partial recovery of an executable file will not be of much help. For this reason, it is important to 

keep your files defragmented (particularly files on FAT volumes). Of course, Diskeeper Corporation 

has the answer for file fragmentation—Diskeeper! 

 Files that have been removed from the Recovery Bin have a unique file identification number added to 

the original filename. (This prevents undeleted files of the same name from overwriting each other.) If 

these files are later recovered with the Search Disk feature, their filenames may be shortened, since the 

file identification is removed when the file is recovered from the disk. If the name part of the filename 

is longer than 32 characters, it is truncated to the first 32 characters when the file is renamed in the 

Recovery Bin. Similarly, if the file extension is longer than 12 characters, it is truncated after the first 

12 characters. 

 Files that have been removed from the Recovery Bin will be listed with the Recovery Bin location as 

their “Original Location”, since that is where they resided before they were really deleted. This is a 

directory folder named \RecoveryBin\ on the volume(s) where you have specified Recovery Bins 

should reside on your system. 

 Note that when files are deleted from the Recovery Bin when the “SecureDelete” feature is enabled in 

the Recovery Bin properties, the deleted files will not be recoverable with the Search Disk feature. 

Using the Search Disk Interface 
The interface for the Search Disk feature offers a limited set of the Recovery Bin menu options, and all of 

the toolbar buttons are disabled. 

After you specify a filename and disk volume location to search for, it also displays a listing of the files 

matching the search criteria that have been really deleted from your disk volume. 

Here is an example of the Search Disk interface: 

                                                                                                                                                                             

to require two or more file records within the MFT. Extremely Huge files are files that contain so much additional file information 

(again, either file security information or the locations of a very large number of file fragments) that more than two file records are 

necessary within the MFT, plus space on the disk outside the MFT is used for storing additional file record information. 
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Follow these steps to recover a file with the Search Disk feature: 

1. Enter the name of the file you want to undelete in the Name: field of the Search Disk display. You can 

use wildcard characters (such as *.doc or *.*) if you don’t recall the name of the file. 

2. Enter the letter of the drive you want to search in the Location: field of the Search Disk display. You 

can optionally enter a folder name (such as D:\My Documents). Use the Browse button to navigate to 

other drives and folders on your computer. 

3. Click Search. This starts the search for deleted files. 

4. Once the search is complete, highlight the name of the file (or files) you want to undelete. 

5. Click Undelete Files…. This causes a dialog box like this to be displayed: 
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6. Enter the drive letter and folder name of the location where you want the undeleted file to be written in 

the Folder: field. Or, use the Browse button to navigate to the location where you want the recovered 

file to be saved. If you have more than one disk volume, be sure to specify a volume other than the one 

where the file was originally located. This prevents the new, recovered file from overwriting portions 

of the old, deleted file. 

7. You are also given the choice to recreate the original directory path (as a subdirectory of the folder you 

specify in the Folder: field). Note that the original directory path will only be recreated if Undelete can 

detect it. 

8. Click OK. The file(s) you have selected will be recovered if possible, and written to the location you 

have specified. 

The interface for the Search Disk feature offers a limited set of the Recovery Bin menu options, and the 

toolbar is disabled, with the exception of the Help button.  

Following are descriptions of the various components of the Search Disk interface: 

Name 

Use this section of the Search Disk display to specify the name of the file you want to undelete. You can 

use wildcard characters (* and ?) in this section of the display. 

You must provide a filename or wildcard sequence (such as *.doc) as a search pattern to use for finding 

files to undelete.  

Note: On FAT volumes, files with short names (8.3 format) that have really been deleted will have the first 

character of the filename replaced by a tilde (~). For example, a file named test.txt, when deleted, will be 

renamed to ~est.txt and will be displayed that way in the Search Disk window.  

Location  

Use this section of the Search Disk display to specify the disk volume and directory folder of the file you 

want to undelete. 

You can use the Browse button to speed up your search for the correct path. 

Browse 

Click this button in the Search Disk display to search for the path of the disk volume and directory folder 

where the file you want to undelete resided immediately before it was deleted. 

 25



Operation 

Note that if you are undeleting a file that has been purged from the Recovery Bin, the disk volume and 

directory folder will be the location you have specified for the Recovery Bin to reside. This is one or more 

folders named \RecoveryBin\ on the individual volumes where you have enabled Recovery Bin processing. 

Include Subfolders in Search 

When this option is enabled, any subfolders below the specified directory folder will be searched for files 

that match the specified search pattern. 

Clear this check box to avoid searching for files in subdirectories below the highlighted directory. 

Search 

Click this button to start the search for the specified files. All detected files matching the search criteria will 

be displayed in the file listing. 

Undelete Files… 

Click this button to undelete any files whose names have been highlighted in the Name column of the 

Undelete display. You can select more than one file at a time to undelete. To select more than one file to 

undelete, hold the <Ctrl> key while clicking on the filenames listed in the Name section that you want to 

undelete. Or, you can hold the <Shift> key to select a continuous list of files in the Name section. 

When you use the Undelete button, a dialog box is displayed, prompting you to specify a disk volume and 

directory folder into which the selected files should be undeleted. 

Important Note: If at all possible, you should undelete files to a volume other than where they originally 

resided. Writing a file (which includes recovering it with the Search Disk feature) to the same disk volume 

where it originally resided can potentially overwrite the very file you are trying to undelete.  

Some other points to consider when undeleting files that have been previously purged from the Recovery 

Bin: 

 Files that have been removed from the Undelete Recovery Bin have a unique file identification number 

added to the original filename. (This prevents undeleted files of the same name from overwriting each 

other.) If these files are later recovered with the Search Disk feature, their filenames may be shortened, 

since the file identification is removed when the file is recovered from the disk. If the name part of the 

filename is longer than 32 characters, it is truncated to the first 32 characters when the file is renamed 

in the Recovery Bin. Similarly, if the file extension is longer than 12 characters, it is truncated after the 

first 12 characters. 

 Regardless of where a file was originally "deleted" from (and moved into the Recovery Bin), a file that 

has been purged from the Recovery Bin will be listed in the Undelete display as having the 

\RecoveryBin\ folder as its Original Location. This is because the \RecoveryBin\ folder was the 

location from which it was truly deleted. 

Note: On FAT volumes, files with short names (8.3 format) that have really been deleted will have the 

first character of the filename replaced by a tilde (~). For example, a file named test.txt, when deleted, 

will be renamed to ~est.txt and will be displayed that way in the Search Disk window.  

Stop 

Click this button to stop an ongoing Search Disk activity, such as searching the disk volume for deleted 

files. 

Close 

Click this button to close the Search Disk feature display and return to the Recovery Bin display. 
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Name 

This column of the Search Disk display shows the original filename and extension of the deleted files. 

Click on the title bar in this section to sort the files by name in forward or reverse alphabetical order. 

Size 

This column of the Search Disk display shows the size of the deleted files. 

Click on the title bar in this section to sort the files by size in forward or reverse order. 

Date Modified 

This column of the Search Disk display shows the date a deleted file was last modified.  

Click on the title bar in this section to sort the files by date in forward or reverse order. 

Original Location 

This column of the Search Disk display shows the disk volume and directory folder where a deleted file 

was originally located. Click on the title bar in this section to sort the files by original location in forward or 

reverse alphabetical order. 

When you recover a file, you should recover it to a different disk volume, to prevent the file data from 

being overwritten. 

Remember, files that have been removed from the Recovery Bin will be listed in the Search Disk or 

Emergency Undelete feature display with the Recovery Bin location as their “Original Location”, since that 

is where they resided before they were really deleted. This is a folder named \RecoveryBin\ on the 

volume(s) where you have specified a Recovery Bin should reside on your system. 

Also, you may see cases where the Original Location is listed as "Unknown". This means Undelete was 

unable to determine the original location of the file. Note that when you recover files with an unknown 

original location, Undelete is unable to re-create the original folders and subfolders in which the file was 

stored. 

Version Protection for Microsoft Office Files  
Have you (or your users) ever worked on an important document, presentation or spreadsheet, diligently 

saving your work as you go, only to discover that the changes you’ve made to the file are not workable, and 

you need to “rollback” to an earlier saved version? 

Undelete captures commonly-used Microsoft Office files when they are overwritten during a save 

operation. This powerful feature allows you or your users to recover previous versions of Microsoft Word, 

Excel and PowerPoint files. 

When you save a Microsoft Office file such as a Word document or an Excel worksheet, the previous 

version is deleted as the new version is being written to your computer hard disk. Undelete can capture 

these previous versions of the file and make them available to you. 

To recover an earlier version of a Microsoft Office file, follow these steps: 

1. Open Windows Explorer. 

2. Navigate to the Microsoft Office file for which you want to recover previous versions. 

3. Right-click the file. You will see a menu similar to this: 
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4. Select View Versions and a listing of the earlier versions of the file is displayed similar to this: 
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5. Select a file and right-click it to see a menu of the options available: 

 

6. From the menu displayed, you can choose from these options: 

a. Recover the selected version of the file (and save it to the location of your choice) 

b. Delete that version of the file 

c. Open that version of the file with the default application for that file type 

d. Open the file with the application of your choice 

 Tip: You can also access earlier versions of Microsoft Office files by right-clicking on them in the 

Undelete Recovery Bin. 

Setting the Recovery Bin Properties 

Use the Recovery Bin Properties button  or the Recovery Bin Properties… option on the Tools 

menu to establish rules for where the Recovery Bin files are stored on your disk(s) and the percentage of 

disk space they will be allowed to use. You can also right-click the Recovery Bin icon on your desktop to 

open the Recovery Bin Properties dialog box. 

Note: This option is not available in the Undelete Desktop Client. 

You can either set “global” rules for all the disk volumes detected on your computer, or set different rules 

for each of your volumes.  You can also set properties for how often files are purged from the Recovery 

Bin. 
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Properties Dialog Box 
Here is an example of the Recovery Bin Properties dialog box: 

 

 

Property Box Tabs 

Click the Property Box Tabs to select the Common Bin display, or the individual drives for which you want 

to set Undelete Recovery Bin properties. 

Use the Global Settings tab to set properties for all the drives on your system, and the individual drive 

letter tabs to set properties for individual drives. 

Note that, depending on which other options have been set in the Global Settings tab display, options 

shown within the individual drive letter tabs may or may not be available. 

Use the Common Bin tab to set properties for a common Recovery Bin. The options on the Common Bin 

tab only apply if you have selected the “One Recovery Bin location for all files” option. 

Each drive has its own Recovery Bin 

When this option is enabled, each drive on which the Recovery Bin is activated has a location specified 

where the Recovery Bin files reside. 

If the Enable Recovery Bin on ALL drives option has been set, the Recovery Bin for each disk volume is 

located on the corresponding volume. 

If the Create one Recovery Bin location for all drives option has been set, the Recovery Bin location and 

size are specified from within the Global Settings tab display. 
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Use one Recovery Bin location for all drives 

When this option is enabled, all files placed in the Recovery Bin are located in a single, common directory 

folder. You can specify the location and name of this folder from within the Common Bin tab display. 

Note that when you specify a single, common Recovery Bin for all your volumes, files that have previously 

been moved to the local Recovery Bins (the folders named \RecoveryBin\) will not be automatically moved 

to the common Recovery Bin.  

Note: Using a Common Recovery Bin on a network server will cause the deleted files on the server to be 

copied into a single location. If a large number of deletions take place on the network, this can add 

considerable I/O overhead. This overhead is apparent not only on the disk where the Common Recovery 

Bin is located, but also on the disk from where the files are being copied. For this reason, a Common 

Recovery Bin is not recommended on a busy server. Instead, enable the Recovery Bin individually on each 

drive. 

Enable Recovery Bin on all drives 

When this option is enabled, the Recovery Bin is activated on all the drives on your system. When the 

Recovery Bin is enabled for all drives, files that are moved to the Recovery Bin are stored in directory 

folders named \RecoveryBin\ on each of the drives (or single drive if using a Common Bin). 

If you have also selected the Create a Recovery Bin on each drive option, use the drive letter tabs in the 

Recovery Bin Properties display to specify the size of the Recovery Bin for each enabled drive. 

Enable/Disable Recovery Bin individually on each drive 

When this option is enabled, you can activate the Recovery Bin on individual drives. This option is useful 

in cases where you do not want all of your disk volumes to be enabled for Recovery Bin processing. 

After setting this option, use the individual drive letter tabs in the Recovery Bin Properties display to 

enable and disable Recovery Bin processing on each drive and to specify the size of the Recovery Bin for 

each enabled drive. 

Turn off Recovery Bin on all drives 

When this option is enabled, deleted files are not moved into the Recovery Bin. Instead, they are fully 

deleted. (Of course, depending on the disk activity after they are deleted, you may be able to recover even 

fully deleted files with the Undelete feature.) 

Disable Recovery Bin when Max Size is reached 

When this option is enabled, files are no longer moved to the Recovery Bin after it reaches the maximum 

size you have specified. Any additional file “deletions” will not move files into the Recovery Bin—instead, 

the files will truly be deleted. (They can, however, still often be recovered with the Search Disk feature.) 

Auto Purge when Bin becomes full 

When this option is enabled, the Recovery Bin is partially purged automatically whenever it fills to the size 

you have specified as its maximum. 

When a file “deletion” causes the Recovery Bin to fill to 100% of its maximum size, files will be purged 

from the Recovery Bin until it is only 80% full. Files are purged from the Recovery Bin on a first-in, first-

out basis. The files that have been in the Recovery Bin for the longest time will be the first files purged 

from it. 

Note that you can also purge files from the Recovery Bin based on how long the files have been in the 

Recovery Bin. You can specify how many days files should be left in the Recovery Bin before being 

purged. This “date-based” purge feature is available from the individual drive tabs and the Global Bin tab. 

As an option, date-based purging can be used together with the Auto Purge function. 
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Display Recovery Bin Full warnings 

When this option is enabled, a message is displayed prompting you to empty the Recovery Bin when it 

reaches the size you have specified. When the warning message is displayed, you should remove files from 

the Recovery Bin by either selecting files to remove or by emptying the Recovery Bin.  

When this option is disabled, no message is displayed when the Recovery Bin reaches the specified size. 

This option is only available when you have also enabled the Disable Recovery Bin when Max Size is 

Reached option. When the Recovery Bin is disabled in this way, any additional file “deletions” will not 

move files into the Recovery Bin—instead, the files will truly be deleted. (They can, however, still often be 

recovered with the Search Disk feature.) 

Do not save zero-length files 

When this option is enabled, zero-length files are not moved to the Recovery Bin when they are “deleted”. 

A zero-length file is actually a file record, which contains no data, so there is little chance you would need 

to recover it. Also, the filenames of zero-length files can needlessly clutter up the Recovery Bin file listing. 

When this option is disabled, zero-length files are moved to the Recovery Bin. 

Enable Recovery Bin Virus Protection 

Some viruses do their damage by forcing the length of a user’s file to zero, which renders that file unusable. 

Selecting the Enable Recovery Bin Virus Protection option provides some added protection against these 

viruses by preventing any files in the Recovery Bins or Common Bin from being made zero length. Note, 

however, this option is no substitute for the use of virus protection software. 

Enable Recovery Bin SecureDelete 

When enabled, this security feature will permanently erase any file that is deleted from the Recovery Bin. 

This is done by overwriting it with a specific bit pattern specified for this purpose by the National Security 

Agency (NSA) for the Department of Defense (DOD). Finally, after the file has been overwritten, it is 

deleted. The SecureDelete procedure makes it virtually impossible for anyone to access sensitive file data 

from a disk after it has been deleted from the Recovery Bin. 

Note: Because the Search Disk feature will be ineffective on files deleted from the Recovery Bin with 

SecureDelete enabled and because of increased disk traffic, SecureDelete should be enabled only when 

security reasons require it. 

Confirm each delete from Recovery Bin 

When this option is enabled, a message is displayed each time you request that one or more files be deleted 

from the Recovery Bin. 

OK 

Click OK to accept any changes you have made to the Recovery Bin properties and to close the dialog box. 

Cancel 

Click Cancel to close the Recovery Bin Properties dialog box without making any changes. 

Apply 

Click Apply to cause any changes you have made to the Recovery Bin properties to take effect, without 

closing the Properties dialog box. 
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Versions tab 
Use the Versions tab to set properties for the Version Protection for Microsoft Office files feature. Here is 

an example of the Versions tab in the Recovery Bin Properties dialog box: 

 

Enable saving of file versions in the Recovery Bin 

When you save a Microsoft Office file such as a Word document or an Excel worksheet, the previous 

version is deleted as the new version is being written to your computer hard disk. Undelete can capture 

these previous versions of the file and make them available to you. 

Enable this option to allow Undelete to save earlier versions of Microsoft Office files matching the file 

types listed in the dialog box. 

Limit each file to n versions 

Use this option to specify the maximum number of versions of a file you want saved by Undelete in the 

Recovery Bin. 

When this option is not enabled (but the Enable saving of file versions in the Recovery Bin option is 

enabled), Undelete will save as many versions of a file as allowed by the space available in the Recovery 

Bin. 

Save versions of these file types 

This section of the Version Properties dialog box shows the Microsoft Office file types for which Undelete 

will save earlier versions. Use the Add to list and Remove from list buttons to add or remove Microsoft 

Office file types from the list. 
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Add to list 

Click this option to add Microsoft Office file types to the list of file types for which Undelete will save 

earlier versions. When you click the Add to list button, a selection box similar to this is displayed: 

 

To add a file type to the list, simply select it in the File types available… selection box and click Add>>. 

When you have added the file types you want, click OK to save your changes and return to the Version 

properties tab (or Cancel to return without saving your changes).  

Remove from list 

Use this option to remove a file type from the list of file types for which Undelete will save earlier versions. 

To remove a file type from the list, select the file type and click Remove from list. 

OK 

Click OK to accept any changes you have made to the file version list and to close the dialog box. 

Cancel 

Click Cancel to close the file version list without making any changes. 

Apply 

Click Apply to cause any changes you have made to the Recovery Bin properties to take effect, without 

closing the Properties dialog box. 
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Common Bin Tab 
The Common Bin display is enabled when the One Recovery Bin location for all drives option has been 

enabled under the Global Settings tab of the Recovery Bin Properties dialog box. Here is an example: 

 

 

Drive 

Use this section of the Recovery Bin Properties display to specify the drive where you want the Common 

Recovery Bin to be located. Note that this option is only available when the Use One Recovery Bin for all 

drives option has been enabled 

Drive space to use 

Use the slider control to specify the maximum size of the Recovery Bin, based on a percentage of the total 

disk space. 

Depending on the other Recovery Bin Properties options you choose, one of two things will happen when 

the Recovery Bin reaches the size set with this option. 

 If you have selected the Disable Recovery Bin when Max Size is reached option, any file “deletions” 

done after the Recovery Bin becomes full will not move files into the Recovery Bin—instead, the files 

will truly be deleted. (They can, however, still often be recovered with the Search Disk feature.) 

 If you have selected the Auto Purge when Bin becomes full option, the Recovery Bin will be purged 

to 80% of its total capacity each time the Recovery Bin reaches its maximum size. Files are purged on 
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a first-in, first-out basis. The files that have been in the Recovery Bin for the longest time will be the 

first files purged from it. 

Drive Space to Use and Recovery Bin Size  

This section of the Recovery Bin Properties dialog box shows the percentage of drive space to use, and the 

size of the Recovery Bin in megabytes. The size of the Recovery Bin is changed with the slider control.  

Purge Files older than ‘N’ days 

With this option enabled, if a file in the Recovery Bin is more than the specified number of days old, it will 

be purged from the Recovery Bin. Use the spin buttons to change the number of days to a figure that will 

work well for you. 

Note that this option works independently of other purge options that can be found under the Global 

Settings tab. 

Individual Disk Volume Tabs 
These are enabled when the Each drive has a Recovery Bin location option has been selected under the 

Global Settings tab of the Recovery Bin Properties dialog box. Here is an example: 

 

Enable a Recovery Bin on this Drive 

This option is available if the Enable/Disable Recovery Bin individually on each drive option was 

selected under the Global Settings tab. 

Select this option if you want to be able to recover deleted files on the drive specified by the currently 

selected tab. If this option is cleared, any files deleted on this drive will not be saved at all. 
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Note that if One Recovery Bin for all drives was selected under the Global Settings tab, the deleted files 

will be saved to the Common Bin, which is likely to be on a different drive. 

Drive Space to Use and Recovery Bin Size  

This section of the Recovery Bin Properties dialog box shows the percentage of drive space to use, and the 

size of the Recovery Bin in megabytes. The size of the Recovery Bin is changed with the slider control.  

Purge Files Older Than ‘N’ Days 

With this option enabled, if a file in the Recovery Bin is more than the specified number of days old, it will 

be purged from the Recovery Bin. Use the spin buttons to change the number of days to a figure that will 

work well for you. 

Note that this option works independently of other purge options that can be found under the Global 

Settings tab. 

Save files deleted from Macintosh shares 

Using Windows Services for Macintosh (SFM) it is possible to make one or more shared folders or disks 

visible to Macintosh computers on your network. Special actions are required by Undelete to save files 

deleted from these Macintosh shares. The actions needed to copy these files into the Undelete Recovery 

Bin involve more work and time than a normal file deletion, and thus Macintosh file deletions from SFM 

served shares may take more time. There is no impact to local files deleted from the Macintosh or to files 

on non-SFM shares on the server. 

Enable this option to cause files deleted from SFM shares to be saved in the Recovery Bin (as long as the 

file is not on the Undelete exclusion list). When this option is not enabled, files deleted from SFM shares 

are not saved in the Recovery Bin. This option is enabled by default. We recommend leaving it enabled 

unless deletion performance on SFM shares is critical to your operation. 

Connect to Network Folder 
Note: This option is not available in Undelete Home Edition. 

Use the Connect to a network folder button  or the Connect Network Folder… option in the Tools 

menu to connect to a folder in a Recovery Bin on a remote computer. 

When you use this option, this dialog box is displayed: 

 

Use the Display as: field to enter a name you want displayed next to the folder in the Recovery Bin tree 

view pane. 
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In the Path: field, enter the network path of the folder to which you want to connect, or click the Browse... 

button to navigate to the folder. 

If you need to enter different login credentials to access the network folder, click Connect As... to enter the 

appropriate login information. 

Click OK to accept your selection and connect to the remote folder, or click Cancel to cancel the 

operation. 

Disconnect from a Network Folder 
Note: This option is not available in Undelete Home Edition. 

Use the Disconnect from a network folder button  or the Disconnect Network Folder…option in 

the Tools menu to disconnect from a folder in a Recovery Bin on a remote computer. 

When you use this option, a listing of the connected remote folders is displayed. Select the appropriate 

folder and click OK. 

Connect to Remote Computer 
 

Note: This option is only available with the Server Edition of Undelete. 

Use the Connect to a remote machine button  or the Connect to Remote Computer… option in the 

Tools menu to recover files from the Recovery Bins or use the Search Disk feature on remote network 

computers. You can also change the Recovery Bin properties on remote computers. (Note: Undelete Server 

or Professional must also be running on the remote computer.) 

When this option is used, a dialog box like this is displayed listing the domains, workgroups, and 

computers detected on your network:  
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Double-click a computer name to connect to that computer, or double-click a domain or workgroup name 

to expand the list of computers within that group. Once the list is expanded, double-click the name of the 

individual computer on which you want to access the Recovery Bin. 

After connecting, you can recover files from the Recovery Bin or use the Search Disk feature on the remote 

computer , as well as change the Recovery Bin properties. 

Recovery Bin Exclusion 
 

Note: This option is not available in the Undelete Desktop Client. 

Use the Recovery Bin Exclusion List button  or the Exclusion List option in the Tools menu to 

create a list of files and directory folders that you want excluded from being processed by the Undelete 

Recovery Bin. When a deleted file (or the folder where it is stored) is excluded from the Recovery Bin, it 

really is deleted from the disk—not moved to another location on the disk (as other files normally are) 

when Undelete is running.  

One example of files you would likely exclude from Recovery Bin processing is temporary files that you 

really do want to delete. These are often files with a .tmp file extension, but many other extensions are 

also used, depending on the applications you are running. A number of common temporary file types are 

excluded from Recovery Bin processing by default. 

Typically, when you install an application, a number of temporary files are created, and then eventually 

deleted by the installation program. Also, compilers and Web browsers often create a large number of 

temporary files. There is little chance you will ever need to recover these temporary files, so by excluding 

them from being processed by the Recovery Bin, the program really will delete them, and they don’t take 

up Recovery Bin space unnecessarily. 

The Recovery Bin Exclusion List gives you very complete, yet flexible control over what files are excluded 

from Recovery Bin processing. You can specify disk volumes, folders, individual files, or a  particular file 

type you want excluded. Or, you can create custom exclusion rules to fit a wide range of needs.  

Exclusion List Dialog Box 
Options available in the Exclusion List dialog vary depending on the type of exclusion rule you are 

creating. If you are excluding specific volumes, folders or files, one set of options is shown. If you are 

excluding a specific file type (such as .log files), another set of options is provided. Or, if you are creating a 

custom exclusion rule, yet another set of options is available. These three variations are shown in the 

following sections. 

Excluding Volumes, Folders or Files 

When you use the Recovery Bin Exclusion List button  or the Exclusion List option in the Tools 

menu, a dialog box similar to this is displayed: 
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The right-hand pane of the dialog box shows everything currently in the Recovery Bin Exclusion List. The 

Add>> and Remove>> buttons in the middle of the dialog box are used to add and remove volumes, 

folders, files or file types to and from the Exclusion List. To add an object to the Exclusion List, select it in 

the left-hand pane and click Add>>. To remove something from the Exclusion List, select it in the right-

hand pane and click Remove>>. 

By default, the Volumes, Folders and Files option is shown in the Type drop-down list. (The other Type 

options are described in the next two sections.) 

Use the Look in: drop-down list to select between the local Windows Desktop, My Computer or My 

Documents. Your selection will be reflected in the dialog box below the Look in: option. Navigate to the 

disk volume, folder, or file you want to exclude as you would with any other standard Windows Browse 

feature. Select the object you want to exclude, then click Add>> to add it to the Recovery Bin Exclusion 

List. 

Enable the Include subfolders of selected folders option to, as the name implies, include subfolders of any 

selected folders in the Recovery Bin Exclusion List. 

Enable the Exclude selected folder on all volumes option to exclude the selected folder on all the volumes 

detected on your computer. 

When you have made your selections, click OK to save your changes and return to the main Recovery Bin 

display or click Cancel to return to the Recovery Bin without saving your changes. You can also click 

Apply to save your changes and keep displaying the Recovery Bin Exclusion List. 
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Excluding File Types 
When you select the File Extension (File type) option in the Type drop-down list, the Recovery Bin 

Exclusion List dialog box changes to display something similar to this: 

 

As before, the right-hand pane of the dialog box shows everything currently in the Recovery Bin Exclusion 

List. However, the left-hand pane changes to show a list of defined file types available to be added to the 

Recovery Bin Exclusion List. Note that these file types are available to be added to the list, but are not 

actually added to the Exclusion List until you select them and click Add>>.)  

By default, a limited number of file extensions are listed, but you can easily add other file types by double-

clicking Enter new and specifying the extension (and description) for any file types you want to add to the 

left-hand pane. Again, file extensions listed in the left-hand pane are not added to the Exclusion List until 

you select them and click Add>>. To remove a file type from the Exclusion List, select it in the right-hand 

pane and click Remove>>. 

When you have made your selections, click OK to save your changes and return to the main Recovery Bin 

display or click Cancel to return to the Recovery Bin without saving your changes. You can also click 

Apply to save your changes and keep displaying the Recovery Bin Exclusion List. 

Creating Custom Exclusion Rules  
The most flexible tool for specifying which files will not be saved in the Recovery Bin is the Custom 

option in the Type drop-down list. When this option is selected, the Recovery Bin Exclusion List dialog 

box changes to something similar to this: 
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Again, the right-hand pane of the dialog box shows everything currently in the Recovery Bin Exclusion 

List. The left-hand pane changes to provide a wide variety of controls you can use to create a custom 

exclusion rule. These controls are fairly self-explanatory. Simply complete the “I want to exclude…” 

statement with selections from the various drop-down lists and Browse options provided. The controls are 

dynamic; the available options change as you complete the statement. For example, if you select to exclude 

Files, you are presented with different options than if you select to exclude Volumes. 

After completing the “I want to exclude…” statement to meet your needs, click OK to save your changes 

and return to the main Recovery Bin display or click Cancel to return to the Recovery Bin without saving 

your changes. You can also click Apply to save your changes and keep displaying the Recovery Bin 

Exclusion List. 

Using the Command Line Interface 
In addition to its Graphical User Interface (GUI), Undelete supports commands from the Windows 

command prompt. Both the Recovery Bin and the Search Disk feature can be controlled from the command 

prompt.  

Two commands are available from the command prompt, reclaim and undelete, which are described on 

the following pages. Both commands support several optional command qualifiers. 

To use either command, follow these steps: 

1. Open the Windows command prompt window. 
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2. Type either reclaim or undelete at the command prompt, followed by any of the optional 

command parameters. 

The RECLAIM Command 
The reclaim command manages files in the Undelete Recovery Bin. Use the command in this form: 

reclaim [Search_Pattern] [/i] [/r] [/d] [/q] [/f] [/?] 

Parameters 
[Search_Pattern] 

Specifies a search pattern of files to search for in the Recovery Bin. This pattern can include the 

following: 

[Drive Letter] 

[Pathname] 

[Filename] 

If no Search_Pattern is specified, all files in the Recovery Bin will be listed. Wildcard characters (* and ?) 

are permitted in the filename. 

/i(nclude) 

Causes the files, which match the other, specified search pattern criteria in all underlying subdirectories to 

be listed. 

/r(ecover) 

Causes the listed files to be recovered from the Recovery Bin. When /r is used, you will be prompted to 

confirm the recovery of the files. 

/d(elete) 

Causes the listed files to be removed from the Recovery Bin. When /d is used, you will be prompted to 

confirm the removal of the files. 

/q(uiet) 

Quiet mode – does not echo files to the screen found during the search, and it does not echo recovered or 

deleted files to the screen, either. 

/f(orce) 

Forces the specified action, when used with the /r or /d parameter. Causes the files to be recovered (or 

deleted) without prompting. 

/? 

Displays the command prompt Help text. 

Examples  
reclaim  /i 

Lists all files in the Recovery Bin. 

reclaim *.doc /i 

Lists all files in the Recovery Bin that are *.doc files. 
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reclaim C:\*.doc /i 

Lists all files in the Recovery Bin that are *.doc files from the C: drive. 

reclaim C:\MyFiles\*.doc /i /r 

Lists all files in the Recovery Bin that are *.doc files from underneath the \MyFiles\ folder on the C: drive. 

reclaim C:\MyFiles\*.doc /d 

Similar to above command, but after listing the deleted files found, it gives you the option to delete these 

files from the Recovery Bin. 

reclaim C:\MyFiles\*.doc /r 

Similar to above command, but after listing the deleted files found, it gives you the option to recover these 

files from the Recovery Bin. 

reclaim C:\MyFiles\*.doc /i /r /q 

Similar to above command, but the total number of files found is shown without listing the individual files. 

If you choose to recover the files, they are recovered without displaying the file names. 

reclaim C:\MyFiles\*.doc /i /r /f 

Similar to above command, but after listing the deleted files found, the files are immediately recovered 

without prompting.  

reclaim C:\ /i /d /q /f 

This deletes all files in the Recovery Bin that are from the C: drive without listing the individual files or 

prompting. The number of files deleted from the Recovery Bin is displayed. 

reclaim /i /q 

Displays the total count of files in the Recovery Bin. 

The UNDELETE Command 
The undelete command lists and recovers deleted files directly from the disk. It is comparable to the 

Search Disk feature. Use the command in this form: 

undelete Search_Pattern [/d=destination_path] [/i] [/?] 

Parameters 
Search_Pattern 

Specifies which drive letter, and/or path and filename to search for deleted files. The search pattern is a 

required parameter. Wildcard characters (* and ?) are permitted in the filename. 

/d(estination) 

Specifies the destination of the files to be undeleted. If this parameter is not used, the files matching the 

search pattern that are candidates to be undeleted will be listed, but not recovered. To recover the files, you 

must specify a valid drive letter and directory folder for the destination. 

 44



Operation 

/i(nclude) 

Causes the files, which match the other, specified search pattern criteria in all underlying subdirectories to 

be listed. 

/? 

Displays the command prompt Help text. 

Examples 
undelete C:\ 

Lists all files deleted from the root folder on the C: drive. 

undelete C:\Sabrina\ 

Lists all deleted files in the C:\Sabrina folder. 

undelete C:\*.doc /i 

Lists all deleted *.doc files on the C: drive. 

undelete C:\*.doc /d=C:\TEMP /i 

Lists all deleted *.doc files on the C: drive and prompts you to undelete any candidate files found to the 

C:\TEMP folder. 
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Emergency Undelete  

C h a p t e r  3  

Emergency Undelete™ 

This chapter describes how to run Emergency Undelete, and provides important additional information. 

The CD-ROM and downloadable versions of Undelete include Emergency Undelete, a unique tool used to 

recover accidentally deleted files and directory folders before you've installed the full Undelete product. 

Since the installation of any software can overwrite accidentally deleted files, Emergency Undelete runs 

directly off your CD-ROM or floppy disk drive, installing no files at all onto your disk drive. 

Important Points for Using Emergency Undelete 
Once a file is deleted, the chances of fully recovering that file decrease considerably when other activity 

occurs on the same disk volume. To improve the possibility of a complete recovery of a file that has been 

accidentally deleted, Diskeeper Corporation recommends the following steps: 

1. Stop all activity on the disk volume where the accidentally deleted file resided. Do not save any files 

that are currently open, since this causes a write operation on the disk. 

2. If the computer is on a network, disconnect the network cable if possible. This prevents disk activity 

caused by remote users from writing over the file you want to recover. (Keep the network cable 

connected if you want to recover the file to a disk volume on a remote computer.) 

3. After Emergency Undelete has located the file, recover the file to a local or remote disk volume other 

than the volume from which the file was recovered. This prevents the deleted file from accidentally 

being written over by the write operation of the recovery process. 

Note: On FAT volumes, files with short names (8.3 format) that have really been deleted will have the first 

character of the filename replaced by a tilde (~). For example, a file named test.txt, when deleted, will be 

renamed to ~est.txt and will be displayed that way in the Emergency Undelete windows. 

 

Known Restrictions and Limitations 
1. When you undelete a file, you must first specify the filename and directory path before finding the 

deleted files. Wildcard statements (such as * and ?) are supported for specifying the filename. 

2. On NTFS volumes, only Small and Large file types3 are eligible for being undeleted directly from the 

disk.  

                                                           

3 In the NTFS file system, four file types exist. Small files are contained entirely within a single record in the Master 

File Table (MFT). Large files are stored elsewhere on the disk, but the index information pertaining to the file, 

including the locations of the various fragments of the file, is contained within a single record in the MFT. Huge files 

are similar to Large files, but they have enough additional file record information (such as additional file security 

information, or a large number of file fragment locations) to require two or more file records within the MFT. 

Extremely Huge files are files that contain so much additional file information (again, either file security information 

or the locations of a very large number of file fragments) that more than two file records are necessary within the 

MFT, plus space on the disk outside the MFT is used for storing additional file record information. 
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Required Privileges 
You must be a member of the Administrators group to operate Emergency Undelete. This is necessary in 

order to conform to NTFS file security. 

Running Emergency Undelete  
The operation of Emergency Undelete is similar to running the Search Disk feature in either the Server, 

Professional or Home edition of Undelete. Of course, you must have the Undelete CD-ROM (or the 

Emergency Undelete floppy disk) in the appropriate drive on your computer.  

Follow these steps to recover a file with Emergency Undelete: 

1. Locate the EmergUnd.exe file on the CD-ROM or floppy disk and double-click it. 

2. Enter the name of the file you want to undelete in the Named: field of the Emergency Undelete 

display. You can use wildcard characters (such as *.doc or *.*) if you don’t recall the name of the file. 

3. Enter the letter of the drive you want to search in the Look in: field of the Emergency Undelete 

display. You can optionally enter a directory folder name (such as D:\My Documents). Use the Browse 

button to see the drives and folders on your computer. 

4. Click Find Deleted Files. This starts the search for deleted files. 

5. Once the search is complete, highlight the name of the file (or files) you want to undelete. 

6. Click Undelete File(s). This causes a new dialog box to be displayed. 

7. Enter the drive letter and directory folder name of the location where you want the undeleted file to be 

written in the Undelete file(s) to path: field. If you have more than one disk volume, be sure to 

specify a volume other than the one where the file was originally located. This prevents the new, 

recovered file from overwriting portions of the old, deleted file. 

8. Click OK. The file(s) you have selected will be recovered if possible, and written to the location you 

have specified.  
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Using PushInstall 

This chapter explains how to use the PushInstall feature to install the Undelete on computers throughout 

your network. 

Note: The PushInstall feature is only available in Undelete Server Edition. 

 

About PushInstall 
Use the Undelete PushInstall feature to install or uninstall Undelete Desktop Client, Professional Edition or 

Server Edition on selected computers throughout your network. Note that you must have valid Undelete 

licenses for the machines on which you intend to install Undelete. 

You must have Administrator access on all the selected computers to PushInstall Undelete to Windows 

2000, Windows XP and Windows Server 2003 systems. If necessary, the PushInstall program will prompt 

you to enter login credentials for the machine(s) to which you are PushInstalling. 

Note: The Undelete PushInstall feature only installs or uninstalls Undelete on machines in the same domain 

as the Undelete Server from which it is run. In other words, you must use PushInstall within a single 

domain. To PushInstall Undelete to a different domain, you must install Undelete Server Edition on that 

domain, then run the PushInstall program from there. 

The PushInstall feature establishes a network connection with the selected machines, then installs the 

selected Undelete edition to those computers. It relies on having the installable Undelete package(s) 

available to be installed. The first time you use the PushInstall feature, the program attempts to detect the 

installable files. If they cannot be found, you will see a dialog box prompting you for the location of the 

installation package. You can use either a CD-ROM or downloaded installation package. Once you choose 

the Setup.exe file, the installation package is copied to a storage area used by the PushInstall program. 

If you try to PushInstall an Undelete version that is not compatible with the target machine, a message 

explaining the situation is displayed. Messages are also displayed to let you know the status of the 

installations.  

Before the PushInstall operation begins, you will see a message asking you to confirm the version and build 

numbers of the installable package.  

When PushInstalling the Undelete Desktop Client, you also have the option to have an Orientation screen 

displayed on the remote computer (for your users’ benefit) explaining how to use it. This helps familiarize 

your users with the Undelete Desktop Client and shows them how to use it to recover their own deleted 

files from the file server running Undelete. 

Also note that Undelete Desktop Client does not replace the Recycle Bin icon, but instead adds an Undelete 

Desktop Client icon to your users’ desktops. 
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Running PushInstall 
Follow these steps to install or uninstall Undelete Desktop Client, Undelete Professional Edition or 

Undelete Server Edition to remote computers on your network: 

1. From the Windows Start menu, select Programs, then Undelete PushInstall.  

2. A welcome screen is displayed. Click Next to continue. You will see a screen similar to this: 

 

1. Select the 
computer(s) to 
which you want 
to PushInstall 

Undelete 

2. Select a product to 
install, or select 

Uninstall to remove 
any edition 

3. Click Next 

3. If necessary, the PushInstall program will prompt you to enter login credentials for the machine(s) to 

which you are PushInstalling. In this case, you will see a message similar to this: 
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Using PushInstall 

Enter a username and password for an account that is a member of the Administrators (or Domain 

Administrators) group for the domain on which you are installing or uninstalling Undelete. 

4. Once the PushInstall process has started, messages are displayed showing you the status of the 

operation. 
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Frequently Asked Questions 

Diskeeper Corporation maintains an up-to-date list of the most frequently asked questions (FAQs) about 

Undelete on their Web site. This list is updated as often as necessary to ensure most common questions are 

answered. Quite often, you can find answers to your questions and solutions to any problems you may have 

regarding Undelete by checking the Diskeeper Corporation Web site. 

The Undelete FAQs are at: 

www.undelete.com/undelete/faqs/faqs.asp
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Supported Operating Systems   

This table shows the different Windows versions and the Undelete editions supported by each. Note that 

Windows 2000 systems must be running Service Pack 3 or higher: 
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Technical Support 

U.S. Support Services 

Registered users are entitled to 90 days of free telephone support, as well as special upgrade pricing, from 

Diskeeper Corporation. Our free technical support is available Monday through Friday during the first 90 

days from 7:00 A.M. to 5:30 P.M. Pacific time. If you have not yet registered your Undelete purchase, 

register your purchase online now via our Web site at: 

www.undelete.com/register

Most technical support questions can be answered from the Technical Support section of our Web site at: 

www.undelete.com/support

You may also contact our technical support team via the Internet at: 

tech_support@diskeeper.com 

or via FAX at: 

818-252-5509 

If you are within your 90-day free support period, or have purchased telephone support, you can call: 

818-771-1600 

When your 90-day free support period has expired, you may purchase the support plan which best suits 

your needs. Diskeeper Corporation offers 24-hour, 7-day support plans. Contact Diskeeper Corporation to 

find out which support options are best for you. 

Diskeeper Corporation’s address is: 

Diskeeper Corporation 

7590 North Glenoaks Boulevard 

Burbank, California, USA 91504 
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Technical Support 

European Support Services 

Registered users are entitled to 90 days of free telephone support, as well as special upgrade pricing, from 

Diskeeper Corporation. Our free technical support is available Monday through Friday during the first 90 

days from 8:30 to 17:30 GMT. If you have not yet registered your Undelete purchase, register your 

purchase online now via our Web site at: 

www.diskeepereurope.com

Most technical support questions can be answered from the Technical Support section of our Web site at 

the address shown above. 

You may also contact our technical support team via the Internet at: 

tech.support@diskeeper.co.uk  

or via FAX at: 

+44 (0) 1342-327390 

If you are within your 90-day free support period, or have purchased telephone support, you can call: 

+44 (0) 1342-327477 

When your 90-day free support period has expired, you may purchase the support plan which best suits 

your needs. Diskeeper Corporation offers 24-hour, 7-day support plans. Contact Diskeeper Corporation to 

find out which support options are best for you. 

Diskeeper Corporation’s address is: 

Diskeeper Corporation UK Inc. 

Kings House, Cantelupe Road 

East Grinstead, West Sussex RH19 3BE 

England
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